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So now filling the news stream are endless reports
of coronavirus (specifically SARS-Cov2) mutations.
There’s the British B.1.1.7. There’s the South African
B.1.351. There’s the California CAL 20C. There’s the
New York B.1.526. There are many, many more
variants of the coronavirus that causes SARS-Cov-2.
And, they are all nasty little buggers.

Yes, we need to monitor these variants so we know
whether or not (or how much) people are at risk, and
to be able to plan how to handle them should they
become the dominant strain. But do we really need
to report on every. single. solitary. variant? Yes, the
scientists and the doctors and the nurses and all the
other healthcare professionals need to know if the
vaccines that are still being rolled out are effective
against these new variants. But does this
information need to flood the airwaves, creating
hysteria?

Most people outside of the scientific and medical
communities simply don’t possess the ability to fully
comprehend the genetic technobabble of these
reports. Hell, there are a lot of scientists and medical
personnel who struggle with it, as well. So probably
the last thing we need are the talking heads on the
nightly news (who probably understand none of it)
causing panic and mayhem. There’s a LARGE gap
between keeping people informed and whipping a
crowd into wild hysteria. The talking heads excel at
the latter. It does, after all, make great headlines,
even at the expense of the truth. And big,
sensational headlines increase viewership, which
increases advertising prices, which increases profits
for the broadcaster.

Remember. This is what virii do. They mutate. They
always have, and will always continue to do so.
Transcription errors in the genetic code of the virus
when it reproduces is one of the things that causes

these variants. Sometimes, the virus adapts to
thwart something that has blocked its ability to infect
and multiply. These mutations can cause a virus to
become more easily transmissible, or just as easily
cause a virus to be more virulent.

These mutations can also go the other way. The
right mutation can cause a virus to become less
transmissible or less virulent. There are some
theories that this is exactly what happened to the
H1N1 influenza virus that was responsible for the
1918 Spanish Flu pandemic. It just mutated itself

right out of the headlines. The mutations of H1N1
caused it to become less virulent, less deadly, and
less transmissible, or so the theory goes.

I’m not advocating for keeping such information
locked away or behind closed doors. But you don’t
have to drive it into the ground with wall-to-wall,
gene-by-gene coverage, either. Like I mentioned
before, there’s a LARGE gap between keeping
people informed and whipping up mass hysteria.
When you drive it into the ground with the wall-to-
wall, gene-by-gene coverage, you are achieving the
latter. Those who want to know more should have
the resources already available to seek out the
additional information, should they desire.

Of course, it also comes into play whether or not the
news media deserve our trust, anyways. Their
recent track record has been way, way, way less
than stellar. Little of what is pawned off as news
today is really news at all, at least by traditional
measures. I know. I was once a member of that
“mainstream media” establishment years ago. The
media today is much more interested in pushing an
agenda than they are in telling the truth or just telling
the story about what happened. And if that story
doesn’t pair well with the agenda they are pushing, it
simply gets omitted, as if it never happened. These
were things that we were taught to NEVER do, no
matter what.

Until next month, I bid you peace, happiness,
serenity, prosperity… and continued good health.

Linux Docs
Linux Man Pages

From The Chief Editor's Desk. . .

http://www.die.net/
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by Paul Arnote (parnote)

Things have been crazy over the past year, with the
latest dose of crazy imposed by the coronavirus
pandemic. As a result, many across the globe have
endured lockdowns and travel restrictions. People
haven’t been as “able” to get out and about in any
manner that they would have normally been able to
do in the times before the pandemic.

Face-to-face meetings have been pretty much out of
the realm of possibilities, out of fear of spreading
COVID-19 to others. The pandemic has definitely
impacted and changed our interactions with others.

New Zealand has done a remarkable job squelching
the effects of the pandemic on its population. The
country of five million people closed its international
borders and imposed mandatory social distancing
early in the pandemic. As a result, New Zealand has
only had just over 2,330 cases of COVID-19, and
just 25 deaths attributed to the virus since the
pandemic started. You would be hard pressed to find
a country in the world that has even come close to
New Zealand’s ability to contain the spread of the
virus.

With things so well under control in New Zealand,
two PCLinuxOS users jumped at the chance to
finally meet, face-to-face. On February 13, 2021,
jimwilk, a.k.a. Jim Wilkinson, traveled with his wife,
Rita, to meet Treedragon and his partner. Both live
in New Zealand. “On a beautiful summer morning, we traveled up the

Coromandel Peninsula and visited the superb
environment that is Treedragon's home. I know we
have all seen Treedragon's great photographs of his
area, but, believe me folks, the area is even better
than depicted in the shots.

“Treedragon and his partner made us very welcome
there in the Coromandel ranges. I sure hope to go
back for another visit sometime soon.”

“We had hoped to meet them last August but, back
then, Covid matters in our largest city Auckland
meant that travel was less easy to justify. There are
currently no restrictions in New Zealand. We thank
our lucky stars each day that we live in this country,”
said jimwik.

Treedragon added, “A pleasure indeed to meet the
man behind the words, and to experience both Jim
and Rita finding enjoyment in their visit.

“The planned earlier visit would have worked even
better with greater arrays of colour and with less of
the drought effect currently starting to really show.
While we were down in the food forest area, I was
asked by Rita, "How do you decide what to do
next....," as she surveyed the array of stuff needing
attention, (note to self). Well, I hesitated on that, as I
had no adequate answer to that eternal conundrum,
but I am pleased with myself for resisting the
temptation to offer pruning shears, rake, harvest
basket or similar. However, I was more than
compensated with a welcome break to the seasonal
routines and a chance to share a little. Maybe next
time, as more visits are promised.

“The lockdown aspect in this country has stopped
visitors from far off lands, and for us being tucked
away off the beaten track, it has meant an increase
in New Zealanders visiting, as they realize there is
magic to be found in their own country. So, thank
you Jim and Rita for taking the opportunity to visit

Connect connections in one
convenient location!

All your
PCLinuxOS

Jim Wilkinson, left, and Treedragon, right.
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and see behind the photographic vista and get a
"feel" of the “place.”

Jim and Rita’s visit to Treedragon’s lair happened
just one day before New Zealand officials instituted a
three-day lockdown for Auckland (New Zealand’s
biggest city) on February 14, 2021, after three
members of one family tested positive for COVID-19
in Auckland. Those new cases now make just four in
the last three months, and the first lockdown in New
Zealand in six months.

I know that the question of meeting other
PCLinuxOS users has, again, recently come up in
the PCLinuxOS forums. While the middle of a
pandemic might not be the best time to meet up with
other PCLinuxOS users, it can be the perfect time to
start planning a meeting for once this pandemic is in
our rearview mirror.

Meemaw and I, despite having “worked together” on
The PCLinuxOS Magazine for many years, have
never met face-to-face. We’ve burned up the email
wires, and always do. We’ve “talked” extensively on
IRC. We’ve texted each other on our cell phones.
We’ve even talked to one another on the telephone.
We are planning/hoping to get together for a trip to
the Kansas City Zoo, just as soon as the weather
turns decent. Even though Meemaw grew up in the
Kansas City area, she hasn’t been to the Kansas
City Zoo in many, many years.

If you live near another PCLinuxOS user, reach out
and try to meet them. PCLinuxOS has always had a
close, family kind of feeling to it, especially among
PCLinuxOS forum members. So, why not try to meet
those other family members? If you do, let us know
about it here at The PCLinuxOS Magazine. We
might just feature your “getting to know you”
escapades in a future issue. And remember …
pictures, or it never happened!

Screenshot ShowcaseScreenshot Showcase

Posted by daniel, on February 14, 2021 , running LXQT
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https://www.pclinuxos.com/forum/index.php/topic,154841.0.html
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INGREDIENTS:

1 pound lean ground beef
1 small onion, chopped (1/4 cup)
1 1/3 cups hot water
1 cup Thick and Chunky medium salsa
1/2 cup milk
1 package Hamburger Helper™ cheeseburger

macaroni
6 flour tortillas, 6 inch
1 1/2 cups shredded Cheddar cheese (6 oz)

DIRECTIONS:

Heat oven to 350F (176C). Cook beef and onion in a
10-inch skillet over medium-high heat, stirring
occasionally, until brown; drain. Stir in hot water,
salsa, milk, uncooked Pasta and Sauce Mix. Heat to
boiling, stirring occasionally. Reduce heat; cover and
simmer about 7 minutes, stirring occasionally, until
pasta is tender.

Cut tortillas in half. Spread 2 cups beef mixture in an
ungreased rectangular baking dish, 11x7x1 1/2
inches, or shallow 2-quart casserole; top with 6
tortilla halves and 3/4 cup cheese. Spread with 2
cups beef mixture; top with remaining tortilla halves.

Top with remaining beef mixture and cheese.

Bake uncovered 15 to 20 minutes or until hot and
cheese is melted.

Nutrition:
Calories: 447.7 Carbs: 27.9
Fiber: 4.4g Sodium: 919.9mg

Defending Your Rights

In The Digital World

PCLinuxOS Recipe Corner

Tortilla Casserole

https://www.eff.org/
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by Paul Arnote

Ever since computers became commonplace and
mainstream, users have sought ways to incorporate
video into their computing lives. In 1984, the CCITT
(now called the ITU-T) created the first main video
compression standard, then called H.120. Its quality
was quite poor, especially when compared to what
computer users today are accustomed to. Despite its
poor quality, it allowed developers to refine their
approach to video encoding, and to achieve the high
quality video we all can access today.

Video files, especially high quality ones, have always
been behemoths when it came to file size. While that
is still true today, the video codecs used today to
encode and compress video result in infinitely
smaller file sizes than raw video, and significantly
smaller file sizes than those codecs used just 20
years ago.

I’m sure that many of you reading this can remember
the infancy of home video, with the relatively low
resolution VHS and Beta tape systems (compared to
DVD and Blu Ray, VHS has resolution of 240 x 320,
vs. 480 x 720 for DVD, and 1080 x 1920 for Blu
Ray). Boy, oh boy, have we ever come a long, long
way since those days! Advances in video

compression standards gave users DVDs, which
offered much higher resolution than the tape-based
home video systems, and much clearer pictures as a
result. DVDs are currently in the process of being
supplanted by Blu Ray discs.

The progression and advances in the past 40 years
has been mind boggling. As CPU speeds have
steadily increased, coupled with drastic advances in
the video processing capabilities of today’s video
cards, advances were inevitable. Add in the
(over)abundance of mobile platforms recording and
streaming unprecedented amounts of video, those
mobile networks crave a video compression
standard that results in smaller file sizes with higher
video quality, all so they can save precious (and
limited) bandwidth on their networks while
maintaining the quality that users expect and
demand. So, the service providers to all those
mobile devices running around out there have an
intense interest in supporting/encouraging the
development of more efficient video compression
standards. A quick search of ITU-T members shows
all three of the “big” U.S. mobile networks (Verizon,
T Mobile, and AT&T) as members.

I’ll leave the “history” of the video compression
standards to Wikipedia, which covers them quite
nicely. We’ll focus our discussion more on the two
current video compression standards that are
available and used today, and the two that dominate
today’s video landscape. We’ll also take a brief peek
into the future of video compression.

H.264

H.264, also referred to as AVC, or Advanced Video
Coding, was released in 2003. It gave rise to the
very common *.mp4 video files we all are familiar
with. In fact, H.264 is the most common video
compression standard used to encode videos on Blu
Ray discs.

Having come out 18 years ago, the H.264 standard
was released before 4K, and now 8K, video was
available. (Forget for a moment that you cannot
even see in 4K, much less 8K, but that is a
discussion for another time.) You will often see the
open source implementation of H.264 referred to as
x264.

As such, H.264 is starting to show its age. It is **just
barely** able to handle 4K video. As for 8K video,
fuggedaboutit. It has to do with how H.264 is set up
to handle CTUs, or coding tree units. H.264 can
handle between 4x4 and 16x16 pixel block size
CTUs. As such, H.264 peaks out just at the level of
4K video.

DOWNLOAD

Mate Desktop

H.264 vs H.265: The Evolution Of Video Codecs

https://en.wikipedia.org/wiki/CCITT
https://en.wikipedia.org/wiki/ITU-T
https://en.wikipedia.org/wiki/H.120
https://www.itu.int/TIES/search.htm
https://en.wikipedia.org/wiki/Video_Coding_Experts_Group
https://en.wikipedia.org/wiki/Advanced_Video_Coding
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H.265

As standards started to be drawn up for 4K video
and beyond, it became apparent that the H.264
standard would need to evolve in order for video
compression requirements to keep pace.

Released in 2013, H.265 expands CTU capabilities
from a 16x16 block of pixels, up to a CTU of 64x64,
and an assortment of other enhancements that
affect performance and file size. H.265 is also known
as High Efficiency Video Coding. The open source
version of the H.265 codec is also known as x265.

Here’s the REAL upside to H.265: smaller file sizes.
When a video is encoded with H.265 versus H.264,
the H.265 video, when encoded at the same
resolution as the H.264 video, will be 40 to 50
percent smaller in file size. So, users can expect
clearer images compressed into a smaller space
than ever before. In my own experiences, H.265
encoded video files were around 40 percent smaller
than their H.264 encoded counterparts. Encoding
was done on the same machine, under similar loads,
at the same resolution.

So, if there’s an upside, there’s always a downside.
That downside is, due to the complexity of the video
compression algorithm, encoding is much slower
with H.265 than H.264. In my own tests, H.265 video
took at least two to three times more time to encode

than the same video encoded with H.264. Using
Handbrake (available in the PCLinuxOS repository),
converting a 93 minute *.webm encoded video to
H.264 encoded *.mp4 video took roughly two hours
to complete its encoding. Just changing the encoder
to using H.265 (and leaving all the other settings the
same as the H.264 encoding), that same 93 minute
video took over five hours to encode in a H.265
encoded *.mp4 file.

As far as the decoding part (which is what happens
when you watch the playback of a compressed
video), that appeared to be seamless and fully
transparent to the end user … which is what you
want. The non-technical consumer of video really
doesn’t care about the encoding side of things. They
are pleased to just be able to watch high quality
video playback.

H.265 appears to be the encoder d’jour, now
represented by up to 40 percent of Blu Ray discs
using the encoder to compress video. It offers disc
makers and content creators a choice of either
having smaller file sizes at the same resolution,
enabling them to offer even more “extra” content on
discs, or offering even higher resolution video than
previously available in the same amount of space
used by H.264 encoded video.

The newer video compression standard supports up
to 8K UHD video, and is the second most widely
used video coding format, right after H.264/AVC.

On a side note, this month’s Tip Top Tips column,
featuring a tip from Archie, centers around
converting video to H.265 using VLC. As with all tips,
your mileage may vary, and mine did when
attempting to do the conversion with VLC. My copy
of VLC would crash whenever attempting to use it to
convert any video to the H.265 encoder. Nearly all of
my “experience” using the H.265 encoder has been
with using Handbrake as the program that handles
the re-encoding/transcoding. Using Handbrake, I’ve
never experienced any problems, aside from my
own impatience, brought on by the much slower

encoding of H.265 video. In the end, I’m always
pleased by the high quality video resolution of H.265
encoded videos and the significantly smaller file
sizes.

What’s The Future?

Don’t think that the ITU-T is resting on its hind
quarters, happy with where H.265 has taken them.
Nope. They are already working on the next version
of video compression. It seems that the “future” may
be just around the corner.

In July 2020, the H.266 video compression standard
was finalized, with the aim of making 4K broadcast
and streaming commercially viable. It is also being
dubbed the “Versatile Video Coding” video
compression standard. (Is it just me, or should they
be running out of superlative adjectives to name
these new video compression standards by now?)

The early claims surrounding VVC/H.266 is that it
will be capable of yet another 50 percent reduction
in file sizes over H.265. When compared to H.264
(by far the most prevalent video compression
encoder in use at the time of the writing of this
article), that will represent high quality video, stored
in a file that is roughly only one-quarter of the H.264
file size. VVC/H.266 will also support up to 16K
video, as well as 360 degree videos.

All of this comes at a cost. Remember me telling you
that H.265 video encoding takes two to three times
as long to encode as it does to encode a video using
H.264? Well, it seems that VVC/H.266 will take up to
10 times as long as using H.265! There is a
significant cost in computing and the time it took to
encode H.266 video, according to an article about

H.264 vs H.265: The Evolution Of Video Codecs

https://en.wikipedia.org/wiki/High_Efficiency_Video_Coding
https://en.wikipedia.org/wiki/Versatile_Video_Coding
https://bitmovin.com/vvc-quality-comparison-hevc/


PCLinuxOS Magazine Page 9

the new video compression standard on
Bitmovin.com. Decoding complexity of H.266 is
expected to be roughly twice that of H.265, too.

There is currently no x266 (open source) encoder for
H.266 available at this time, either. However, the
same group, MulticoreWare, who oversaw the
creation of the x265 codec, is also overseeing the
creation of the forthcoming x266 open source
implementation of the H.266 video compressor.

I suspect that the resource-heavy compression and
encoding of H.266 will be somewhat mitigated by
newer, more powerful CPUs and GPUs, as they
come out on the market for the general consumer.

Also, don’t discount some company or consortium
that just dumps everything that ITU-T has done, and
tries to take the whole process in a whole new
direction. Even though it seems like it might be a
colossal undertaking, there are companies out there
doing just that. One such company is Cinegy LLC,
with their Daniel2 codec. They have literally thrown
out the bath water, the tub and the baby, and left all
legacy dependencies and old codec architectures
behind to create a fully-GPU based
encoder/decoder. In the process, they claim to have
created the world’s fastest decoder. It’s no secret
that GPUs use incredibly fast processors (typically,
far faster than CPUs), so it makes sense to offload
some of the CPU-intensive work to the GPU. And,
it’s going to be the GPU anyways that is responsible
for displaying the video image, thereby eliminating

the bottleneck between the slower CPU and the
faster GPU.

Here’s the summary statement by Cinegy about the
Daniel2 codec, from their website:

“Traditionally video codecs have been defined by chip
makers and not by software developers. Daniel2 is
different. It was designed by software developers that for
decades had suffered implementing "industry standard"
codecs such as MPEG2 or H.264 in software running on
ordinary PC hardware, but these had not been created
with PC hardware in mind. Daniel2 was designed to be a
massively multithreaded parallel processing software
codec that runs extremely fast on CPUs and even faster
on GPUs with their thousands of parallel cores and ultra
fast RAM.”

It will be interesting to see if the Daniel2 codec, or
any other alternative codec, receives any traction in
the market, which could prove to be an
insurmountable obstacle. Users aren’t going to be
any too happy to lose legacy support, which is part
of what Daniel2 does. Still, since “the Daniel2 codec
is acquisition and production codec meant to be
used for recording from camera sources, editing and
post-production as well as playout,” users may still
see some benefit from its use earlier on in the
production cycle.

Summary

Things could get quite interesting for video
enthusiasts in the next few coming years. Higher
resolution video stored in smaller files sounds like a
win, win, win for everyone concerned. Sure, the
newer video compression codecs are slower to
encode and require a LOT of computing power and
time, but that is a one time expenditure. The end
results will be worth it, allowing users to store more
high quality content in the finite spaces they have
available.

Podcasts For
Linux & BSD

H.264 vs H.265: The Evolution Of Video Codecs
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https://www.daniel2.com/index.php/products/daniel2-codec


PCLinuxOS Magazine Page 10

Screenshot ShowcaseScreenshot Showcase

Linux Docs
Linux Man Pages

Support PCLinuxOS! Get Your Official

PCLinuxOS
Merchandise Today!

Posted by Knot-2-Smart, on February 1 , 2021 , running KDE.

http://www.die.net/
http://www.dosgamesarchive.com/
http://www.cafepress.com/pclinuxos


PCLinuxOS Magazine Page 11

by The Cat

On July 2020, on its “Schrems II” judgment, the
Court of Justice of the European Union (CJEU)
invalidated the European Union-United States
Privacy Shield, an international agreement regarding
the storage and processing of personal data from
European Union (EU) residents by businesses in the
United States. While many politicians and the media
expressed their surprise and concern of such an
outcome, the Privacy Shield invalidation was an
announced failure for most of those acquainted with
the very different views on privacy held by the US
and the EU, and on the not very successful
diplomatic history regarding transatlantic treaties on
those matters.

(photo by openDemocracy)

The Privacy Shield, a problem child born on the
Harbor

Back in the late 80’s, Europeans started to concern
themselves with how their personal data was being
stored and processed. As a consequence, came the
Safe Harbor decision in 2000, establishing privacy
principles on EU-US personal data transfers for
commercial purposes. Nevertheless, the
Amendments Act of 2008 to the US Foreign
Intelligence Surveillance Act (FISA), adding the
controversial Section 702 empowering NSA’s PRISM
program and exposed by Edward Snowden, resulted
in an increasing distrust from the European side,
resulting in its invalidation by the CJEU in 2015.
Politicians and businesses tried to save the
agreement with a slightly improved and patched

version – the Privacy Shield –, in 2016. However,
the CJEU didn’t swallow it and nullified the
agreement. So, what to do now?

Things don’t look very shiny for the American
counterpart. As there was no period of grace in the
court decision, at this time you or your contractor
should already have implemented (or is
implementing) the measures determined by the
Court, with the risk of being fined by some European
data protection agency. Some recent examples
show that they are not taking it easy: on October
2020, H&M's Service Center in Hamburg had a 35.3
million Euro fine for the unlawful monitoring of
several hundred of its employees by its
management, and Twitter was fined on more than
US$ 500,000 on December 2020 by Ireland’s Data
Protection Commission for having failed to notify a
data breach on time and to adequately document
the breach.

Now you may be thinking, “I am in the US, so I am
not under the jurisdiction of this European court,
they have nothing to say about the way I run my
business”. This is true, at least in part, because the
European Union changed its approach toward the
definition of personal data. With its growing
importance as an asset to both companies and
governments, the EU’s General Data Protection
Regulation (GDPR), that entered into force in 2018,
started to consider data as a highly valuable good,
and as so, subject to certain export rules, as any
other good. Therefore, when your company
processes or stores personal data in the US, you are
importing this good named “personal data'' from the
EU and executing the tasks your business partner
asked you.

The Privacy Shield was like a “free trade agreement”
regarding the importing of European data. With its

The End Of The EU-US Privacy Shield:
A Great Challenge for Businesses

http://curia.europa.eu/juris/document/document.jsf?docid=228677&mode=lst&pageIndex=1&dir=&occ=first&part=1&text=&doclang=EN&cid=847607
https://www.flickr.com/photos/opendemocracy/1441901063/sizes/o/
https://www.eff.org/deeplinks/2018/02/problems-fisa-secrecy-and-automatically-classified-information
https://www.eff.org/deeplinks/2018/02/problems-fisa-secrecy-and-automatically-classified-information
https://www.eff.org/702-spying
https://www.dataprotection.ie/en/news-media/press-releases/data-protection-commission-announces-decision-twitter-inquiry
https://www.dataprotection.ie/en/news-media/press-releases/data-protection-commission-announces-decision-twitter-inquiry
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annulment, you fall under stricter rules to be able to
keep importing this data, which are: adopt
appropriate safeguards and provide a level of
protection equivalent to that found on European
countries. The “appropriate safeguards'' demanded
by the GPDR are one of the following:

- standard data protection contractual clauses
(SCCs): adding special, previously EU approved
clauses in your contract;

- ad hoc contractual clauses: tailored to your
business specificities, but more risky, as they are not
previously approved as the SCCs:

- binding corporate rules: for groups of enterprises;

- codes of conduct;

- certification mechanisms: by now they are few, and
normally quite costly.

In general, the simplest way for small and medium
enterprises to adopt these “appropriate safeguards”
is by employing SCCs, for having been written and
previously approved by the EU. But remark that they
will change soon. And you will have to change your
clauses again! Here is their draft text, still subject to
modifications.

In addition to those appropriate safeguards,
companies must provide an equivalent (but not
identical) level of protection that one would find
inside the EU. To implement this there is no one-
size-fits-all formula. The EU states that those
measures should be taken on a case-by-case basis,
according to the kind of operation being performed,
and the kind of data being stored/processed.

For it, you should first make an assessment on the
intrinsic risks of your activity, like hackers,
infrastructure and the like, and indicate what
measures you will take to counter these risks, like
strong cryptographic keys, secure servers,
measures to avoid loss of data and damage to

devices, etc. Until there, nothing new, you would
probably say. The new issue is that the CJEU stated
that the Section 702 of FISA and the Executive
Order (E.O.) 12333:

“Allow the surveillance of individuals who are not United
States citizens located outside the United States in order
to obtain ‘foreign intelligence information’, and provides,
inter alia, the basis for the PRISM and UPSTREAM
surveillance programmes. In the context of the PRISM
programme, Internet service providers are required,

according to the findings of that court, to supply the NSA
with all communications to and from a ‘selector’, some of
which are also transmitted to the FBI and the Central
Intelligence Agency (CIA)”.

Moreover, “Section 702 of the FISA does not indicate
any limitations on the power it confers to implement
surveillance programmes for the purposes of foreign
intelligence or the existence of guarantees for non-US
persons potentially targeted by those programmes.”

CJEU’s building (photo by katarina_dzurekova)

The End Of The EU-US Privacy Shield: A Great Challenge for Businesses
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The most concerning, according to the CJEU is that
“data subjects have no right to an effective remedy”
in the courts against US authorities. This doesn’t
relate only with data inside the US, but also passing
by it through its backbones. In the UPSTREAM
program:

“Telecommunications undertakings operating the
‘backbone’ of the Internet — that is to say, the network of
cables, switches and routers — are required to allow the
NSA to copy and filter Internet traffic flows in order to
acquire communications from, to or about a non-US
national associated with a ‘selector’. Under that
programme, the NSA has, according to the findings of that
court, access both to the metadata and to the content of
the communications concerned.”

Here lies thus the big challenge for American
businesses and their European counterparts. They
have to implement technical measures that avoid the
access to the data they store/process by the US
government under FISA and E.O. 12333 while at the
same time abiding to American laws. This could
include, for example, a statement, followed by the
necessary technical measures, that they have not
left purposefully open backdoors or spyware in their
systems, encrypting everything, handling
cryptographic keys to the European counterpart and
don’t keeping a copy of them, anonymizing or
psedonymizing data before receiving it, not keeping
logs or deleting them as soon as possible, etc.
However, if this seems impossible due to the nature
of your business, you unfortunately will not be able
to store/process personal data from the EU in the
US and should stop doing it immediately.

A Great Challenge for US Companies

American and European companies will have to use
all their creative power to develop such challenging
tools that comply with both US and EU law. Whether
you are in the European Union or in the United
States, check with your transatlantic business
partner if you are fully compliant. The Court’s

decision is in force since July 2020, without a period
of grace, and, as you saw, the measures to be
implemented are not easy and are time-consuming.
Moreover, the several European data privacy
agencies are being tough with non-compliance,
imposing hefty fines.

More Information

- The General Data Protection Regulation (GDPR):
https://gdpr-info.eu/

- EDPS Website Evidence Collector, a free and open
source software developed by the European Data
Protection Supervisor for the automation of privacy
and personal data protection inspections of
websites: https://edps.europa.eu/press-publications/
edps-inspection-software_en

- GPDR Checklist: https://gdpr.eu/checklist/, a
lengthy checklist of all that must be implemented,
with some templates and FAQs

- The European Data Protection Board’s
recommendations and examples for implementing
those measures: https://edpb.europa.eu/sites/edpb/
files/consultation/edpb_recommendations_202001_s
upplementarymeasurestransferstools_en.pdf

Users Don't
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Follow PCLinuxOS on Twitter!

http: //twitter.com/iluvpclinuxos

The End Of The EU-US Privacy Shield: A Great Challenge for Businesses

http://twitter.com/iluvpclinuxos
http://www.commandlinefu.com
https://gdpr-info.eu/
https://edps.europa.eu/press-publications/edps-inspection-software_en
https://edps.europa.eu/press-publications/edps-inspection-software_en
https://gdpr.eu/checklist/
https://edpb.europa.eu/sites/edpb/files/consultation/edpb_recommendations_202001_supplementarymeasurestransferstools_en.pdf
https://edpb.europa.eu/sites/edpb/files/consultation/edpb_recommendations_202001_supplementarymeasurestransferstools_en.pdf
https://edpb.europa.eu/sites/edpb/files/consultation/edpb_recommendations_202001_supplementarymeasurestransferstools_en.pdf


PCLinuxOS Magazine Page 14

by David Pardue (kalwisti)

Connecting to an FTP Server with PCManFM-Qt
in LXQt

Introduction

In my previous article, I omitted the LXQt desktop
environment because I am not well acquainted with
it, and was unsure about the status of its “parent”
(LXDE). Although LXDE coexists with LXQt and is
technically still being maintained, it is living on
borrowed time because it has a GTK2 codebase.
LXDE’s most recent stable release dates from 2016.
LXDE’s founder, Hong Jen Yee (aka “PCMan”),
found it impractical to base LXDE on GTK3. GTK3
broke backward compatibility and caused
components to become more memory-hungry and
slower. So Dr. Hong1 began experimenting with Qt
as a base; eventually, his LXDE-Qt project merged
with the Razor-qt project (in July 2013). LXQt is now
the successor to LXDE. Although a bit rough around
the edges compared to LXDE, LXQt is very usable
and is progressing towards its goal of reaching
version 1.0. (Its current release is 0.16.0). LXQt’s
primary goals are simplicity and being light on
resources, with sensible default settings that meet
most users’ needs.

I have been testing the PCLinuxOS LXQt
Community Release, created by daniel (Daniel
Meiß-Wilhelm), on a spare partition of my trusty
netbook.2 This version resembles a Mini.iso, insofar
as it does not include a large collection of
applications; however, the applications are well-
integrated, responsive and the system is visually
appealing. The screenshots were taken from the
most recent 2020.11 release.

FTP with FileZilla

As I discussed earlier, one approach to transferring
files on your home network (“home cloud” or “NAS
Lite”) is to use a reliable FTP client such as FileZilla.
The FileZilla method works identically to what is
described in the MATE section (in my first article).

Via FTP (using PCManFM-Qt [0.16.0])

The PCManFM file manager was originally
developed as a lightweight alternative to Gnome’s
Nautilus. The LXQt version is known as PCManFM-
Qt. The file manager can connect to a remote server
via FTP and Samba. We will discuss FTP access
here.

Option A

From PCManFM-Qt’s Go menu > select Connect to
Server. The “Connect to remote server” dialog
window opens. Under Type, choose FTP.

Supply the information as shown at top right.

Click the OK button. The “Mount” dialog window
appears.

Check that the Connect anonymously radio button is
selected. Click the Connect button. It connects to the
FTP server.

Sharing A USB Drive From Your Wi-Fi Router, Part 2

http://www.commandlinefu.com
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Option B

From the View menu > Path Bar > choose Location
mode.

In the Location bar / box, type in the path as shown
below. Next, click the “Go” button (the downward
arrow icon). (center, top)

The “Mount” dialog window appears (center).

Check that the Connect anonymously radio button is
selected. Click the Connect button. It should connect
to the FTP server.

For comparison’s sake, below is a screenshot of the
Path Bar in Path Buttons mode. You cannot type
anything in the Location bar when it is in this mode:

To Add a Bookmark

In the side pane, under Devices, click on the FTP
server’s URL to select it.

From PCManFM-Qt’s Bookmarks menu > choose
Add to Bookmarks.

A new bookmark will be created in the side pane,
under Bookmarks.

Sharing A USB Drive From Your Wi-Fi Router, Part 2
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To change the bookmark’s name, right-click on
192.168.0.1 and select Rename Bookmark.

Type in the new name: TP-Share. The bookmark’s
name will be changed.

Split View

PCManFM-Qt added a new split-screen feature with
release 0.14.0 (January 2019), which makes it
convenient to copy files between two different
locations.

Activate this from the View menu > Split View. Or,
press the F6 function key.

Here is a screenshot of PCManFM-Qt with its Split
View. The guest user’s /home directory is on the left
side of the screen, while the FTP server (TP-Share)
is visible on the right side.

If you would like to read in more detail about
PCManFM-Qt’s features, or how to customize its
behavior, the Lubuntu Manual devotes one chapter
to the file manager. You can read it here.

1 In addition to his work in computer programming,
Hong Jen Yee is a physician – specializing in
rheumatology – at Taipei Veterans General Hospital

(Taiwan). He temporarily stopped development of
PCManFM in 2008, to focus exclusively on his
medical studies.

2 HP Mini 210 with an anemic Intel Atom N455
processor and 2 GB of RAM (the maximum allowed).
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by Paul Arnote (parnote)

CAT S42 Antimicrobial, Washable Cell Phone

Press Release: Bullitt Group, the global licensee for
Cat® phones, today announced that the Cat S42
has been enhanced by advanced antimicrobial
product protection, making it the first antibacterial
phone. Every exterior component of the product has
been treated with Biomaster® antimicrobial
technology and tested to ISO 22196.

Based on the inclusion of silver ions during
manufacturing, the process creates a permanent
level of product protection, inhibiting the growth of
microbes on the phone surface and therefore
reducing microbial levels on the surface.

Research shows that our phones are home to
thousands of germs, with one University of Michigan
study finding in excess of 17,000 bacteria on
handsets. We interact with our mobile devices many
times a day – around 47 times, on average,
according to research from Deloitte. Mobile phones

are handled and pressed to our faces, meaning that
any bacteria or other microorganisms can easily
transfer back and forth between the hard surfaces of
your phone and your skin.

The Biomaster active antimicrobial agent is proven
to inhibit bacteria cells from replicating, in testing a
reduction of over 80% within 15 minutes was shown
and 99.9% within 24 hours. Combined with the
existing Cat phone rugged credentials that ensure
the device can be thoroughly and regularly washed
with soaps and water, sanitisers, and even bleach,
the Cat S42 represents the next generation of
hygienic product protection in smartphone design.

“Throughout 2020 we have consistently been driving
awareness of the importance of mobile hygiene for
us all, but this is vital for those among our customers
working within a health or social care setting, and
those visiting multiple sites for their job,” said Peter
Cunningham, VP Product Portfolio at Bullitt Group.
“Using a Cat phone already allows them to have
confidence that they can wash and sanitise their Cat
phone regularly or between visits. The addition of
antimicrobial product protection into the Cat S42 is
another first for Cat phones, and will make the Cat
S42 safer for users – such an important feature in
the current climate.”

The Biomaster-treated Cat S42 will be available from
early 2021, with the treatment coming to other
devices in the Cat phones range later in the year.

Tested to Cat phones’ demanding rugged standards,
the Cat S42 features MIL SPEC 810H and IP68 and
IP69 ratings, and surpasses our rigorous and
repeated drop testing from 1.8m onto steel, including
multiple drops onto every side and corner. It’s fully
waterproof, tested submerged in water at depths up
to 1.5m for 35 minutes. Like all Cat smartphones in

Short Topix: 10 Year Old
Sudo Security Bug Patched
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the range, it is also put through vibration and tumble
tests, salt mist conditions, and it’s built to operate in
high and low extremes of temperature and to survive
thermal shocks. Take it with you anywhere and
everywhere. It’s built tough to help you thrive in
challenging outdoor work situations and extreme
leisure pursuits alike.

The Cat S42 Smartphone has an MSRP of £229 /
€249. The S42 with antimicrobial protection will be
available in early 2021. For more information visit
www.catphones.com.

Key Specifications

* Powerful 4,200mAh battery

* Water / Dust proof (IP68, IP69), Drop tested to
1.8M onto steel, MIL SPEC 810H, Corning® Gorilla®
Glass 5

* Waterproof Smartphone – up to 1.5 meters for 35
minutes

* 5″ HD+ 18×9 display optimised for outdoor use
with a touchscreen that can be used with wet fingers
or when wearing gloves

* Android™ 10 (with upgrade to 11)

* 3GB RAM, 32GB ROM, Expandable Storage
(microSD™)

* Mediatek Helio A20 MT 6761D chipset, 1.8GHz
quad-core processor

* 13MP rear camera, 5MP front camera

* LTE Cat 6, VoLTE, VoWiFi

* Textured, extra grip design

* Programmable Shortcut Key useful for Push to Talk
(PTT), SOS (Lone worker app), or to easily launch
its torch or camera

* Bluetooth 5.0, NFC

* 5mm audio jack (waterproof)

* Curated apps and content catalogue

* Dual SIM – Nano SIM + microSD™

* 2-year warranty

* Android Enterprise support

* Security updates cover for 3 years

* Zero-touch support

Editor’s Note: The phone appears to only be
available in the UK at the moment, but US
customers can sign up for a notification of when it’s
available. The estimated MSRP for the phone is
expected to be around $300 (US). While it probably
isn’t necessarily the most powerful cell phone
around, most people buying this phone aren’t buying

it for its power. They are buying it for its antimicrobial
properties and its ability to be washed with soap and
water, or even bleach. It appears that nearly all CAT
phones can be washed, but the S42 is the first
model to incorporate the Biomaster antimicrobial
properties into the phone case. For more information
on just how filthy your cell phone might be, check
out the study from the US National Library of
Medicine and the National Institutes of Health.

How Much Is Your Data Worth On The Dark Web?

Comparitech researchers analyzed over 40 dark
web marketplaces to find out how much your credit
card, Paypal, and SSN are worth to cybercriminals,
and they revealed their findings in a report on their
blog.

Any time your personal data is stolen through either
a data breach or a successful phishing attack, more
often than not your data will end up being sold on
one of the many marketplaces that sell your data.

The prices for that data depend on several things.
One is where you live. If you live in the US, your
credit card data may only be worth an average of
$1.50, but credit card data belonging to a resident of
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Japan may go for as much as $8. Other stolen credit
card information can go for as high as $986. Of
course, you may or may not be on the ropes for any
charges made using your stolen credit card
information, depending on where you live and
whether or not you notice the charges.

Your Social Security number (SSN) (or other
nationally issued identification number) isn’t worth
much by itself, but is often packaged into what’s
called “fullz,” shorthand for full credentials, which
couples it with other vital information that might
make it useful. Fullz from the US run for a measly
$8, while fullz from UAE, Japan and Europe go for
over three times as much, at $25.

Hacked PayPal accounts can range in price from $5
to $1,767. See, nothing is sacred.

This only illustrates why it’s so important to
safeguard your personal information. You should
also go to the Comparitech website to read the rest
of their report. It will give you a much better idea of
how much of your information is vulnerable.

10 Year Old Sudo Security Bug Patched

A 10 year old “vulnerability” has been discovered in
the code that makes up sudo, which is commonly
used in Linux and Unix systems, according to an
article on TechPost. Now, don’t get all indignant or

worried. So far, the vulnerability mostly appears to
be only a “proof of concept” vulnerability. However,
rogue botnets which attack Linux systems (and they
are becoming more prevalent by the day) might be
able to gain low-level access to affected systems via
brute force attacks, and allow root access to the
botnet, which can then wreak havoc on targeted
systems.

Qualys is the firm that discovered the vulnerability,
and it appears to only be accessible to users who
already have access to a Linux/Unix based system.
The bug requires local access, such as a user
already having an account, or being granted SSH
access, and was introduced in a code update in
sudo that dates back to 2011. It involves a buffer
overflow situation, where the buffer is read beyond
the escape characters that tell sudo to stop. Those
extra bytes can be changed, and in the process,
somehow elevate user privileges. The bug was
named by the Qualys researchers as “Baron
Samedit,” and can be tracked using the assigned
code CVE-2021-3156.

The sudo authors have updated sudo with a patch
(reported to be a relatively easy fix), and it appears
in version 1.9.5p2 of sudo. If you’re a sudo user,
you’ll be happy to know that the patch doesn’t
fundamentally affect how sudo works.

CentOS Gets Another New Fork: AlmaLinux

As we reported in the January 2021 issue of The
PCLinuxOS Magazine, RHEL announced that
CentOS was changing directions as of December
31, 2020. CentOS is a favorite for servers across the
world, and RHEL’s change of CentOS to CentOS
Stream didn’t settle too well with CentOS users.

In response, one of CentOS’s founding members,
Greg Kurtzer, went back to work to create Rocky
Linux. The Kurtzer-led replacement for CentOS is on
track for a second quarter 2021 release.

Meanwhile, CloudLinux has also chosen to fork
CentOS into a new distribution, named AlmaLinux. It
seems that CloudLinux is putting their money where
their “mouth” is, by backing the new CentOS
replacement with $1 million (US) annually.
AlmaLinux currently has beta ISOs available on its
website, and is based on the current RHEL 8.
CloudLinux has promised to update AlmaLinux as
RHEL is updated, just as has been done with
CentOS over the years.

Donate NOW
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According to an article on TechRepublic, everything
on AlmaLinux works pretty much the same as on
CentOS, with one exception. Currently, cPanel isn’t
yet working on AlmaLinux. This should be remedied
in subsequent releases of AlmaLinux, since cPanel
currently works on CloudLinux.

According to the statement on the AlmaLinux
website, “we intend to deliver this forever-free Linux
distribution in Q1 2021 – initially built by our own
expertise, but owned and governed by the
community.”

It will be interesting to see the differences between
AlmaLinux and the forthcoming Rocky Linux. As we
mentioned in our first article, the whole situation with
CentOS is rapidly evolving, and continues to evolve
at a brisk pace.

PCLinuxOS Short Topix Roundup

Electronic Frontier Foundation (EFF) has reported
that nearly a year after they called on Amazon to
offer end-to-end encryption on its Ring doorbell

camera feeds, Amazon has responded with just that.
Encryption, though, isn’t the default setting, and
users will have to turn encryption on deliberately.

EFF has also penned a scathing condemnation of
government-operated autonomous robots and the
surveillance threats they impose on the public.
These rolling, trashcan-looking robots not only use
cameras to navigate their surroundings, but they
also are capable of recording all cell phones – down
to each individual MAC address – that are, say, in an
prescribed area surrounding a protest or gathering.

Thus, if your cell phone details are vacuumed up in
a sweep of the area, you are incriminated as a
participant, even if you have nothing to do with the
protest or gathering.

Lifehacker covers a new Google Maps feature on
Android phones. The new feature allows users to
display the map in the lower half of the screen, while
displaying the street-view of the current location at
the top of the screen. The article gives step-by-step
instructions on how to activate the split-screen
display.

Screenshot ShowcaseScreenshot Showcase

Posted by mutse, on February 4, 2021 , running Mate.
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INGREDIENTS:

1/3 cup bittersweet chocolate chips (2 oz)
2 tablespoons sugar
1/8 teaspoon salt
1/2 teaspoon vanilla
1/2 cup heavy whipping cream
Sweetened whipped cream, if desired
Chocolate curls, if desired

DIRECTIONS:

1 Place chocolate chips, sugar, salt and vanilla in a
blender.

2 In a small microwavable bowl, microwave whipping
cream uncovered on High, in 20-second increments,
1 to 2 minutes or until cream begins to boil. Pour hot
cream into the blender; cover and blend until
smooth.

3 Pour chocolate mixture into 2 small dessert bowls.
Cover and refrigerate at least 2 hours until set and
cold. Garnish with sweetened whipped cream and
chocolate curls.

TIPS:

To make chocolate curls, let the bittersweet
chocolate bar stand at room temperature for 15
minutes. Pull vegetable peeler across the edge of
the bar using long strokes.

Semisweet chocolate chips can be substituted for
bittersweet chocolate in this recipe.

NUTRITION:

Calories: 352 Carbs: 21
Fiber: 0g Sodium: 51mg

The PCLinuxOS
Magazine

Created with
Scribus

PCLinuxOS Recipe Corner Bonus

Chocolate Pots de Crème for Two

http://www.scribus.net
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by Meemaw

We were looking at Michael Davies’ list of his top 10 GIMP filters. From the site
Davies Media Design, we’re looking at his top ten favorite GIMP filters. The list is:

1. Gaussian Blur
2. High Pass - We did this one in January
3. Unsharp Mask - We did this one in January
4. Newsprint - We did this one in January
5. Drop Shadow - We did this one in January
6. Long Shadow
7. Vignette
8. Add Border
9. Bump Map
10. Little Planet

Gaussian Blur

I’ve used this filter (Filters > Blur > Gaussian Blur) to soften photos just a bit,
but Davies points out that you can use it to fix a photo problem. Sometimes we
want to use the subject of a photo, but not the background. After cutting away the
background we’re left with some rough edges on the subject. Gaussian Blur can
help minimize them.

In this image we have a white
flower and many green leaves.
Suppose I wanted to add this
flower, but not the leaves, to
another floral image.

Using the “Intelligent Scissors”
tool, I can draw around the image
(next column, left top):

While I’m not too accurate, each
line can be moved on your way
around, before you click OK (next
column, top right).

Notice that in several spots I have some green at the end of my petals. That
probably won’t bother anyone in the artwork I’m doing, but we all want to make
things look as good as possible. Just setting Gaussian Blur at .24 (X and Y
radius) will soften the edges a bit.

GIMP Tutorial: Top GIMP Filters, Part 2

https://daviesmediadesign.com/
https://daviesmediadesign.com/project/top-10-gimp-filters/
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This filter could be most useful on a picture of a person with a background you
didn’t like. You could cut the person out and change the background to something
you like better, or add them to another photo.

Another neat effect is to draw a stroke around your cutout (you can put it in its
own layer) and then use the Gaussian Blur on the stroke. Depending on the color
of your stroke, you can make a sort of “glow” effect on your cutout. I found an
adorable baby picture on Pixabay (all their stuff is free), cut out just the baby, then
added a layer where I drew around her with a 3 px paintbrush. You could
probably use as large an outline as you wanted, but I’m not sure I’d go much
more than 5, depending on the effect I wanted.

If I turn off that layer, the line goes away, but if I turn it on and use Gaussian Blur
on it, I get a kind of shiny halo around her. It kind of de-emphasizes any mistakes
I’ve made while cutting her out, and may even emphasize her soft hair.

I imagine if my line was white instead of yellow, the blur would look silvery. That
would be useful on many designs!

Long Shadow

This is a fun filter! When I first started experimenting with it, I used the gardenia I
was using above. There are several settings here. The shadow can be adjusted
according to size and direction, but also according to how you want the shadow
to look. Using the gardenia, I left the length at 100 and the angle at 45 (changing
the angle changes the direction of the shadow), then changed the shadow to a
light green.

I thought that it would be good to find out how it looked with text (we put shadows
on our text often, to emphasize the message of our text). The regular drop
shadow looks completely different. The long shadow gives the effect of the text
sort of zooming toward you. Depending on your settings, it can be solid like the
one on the gardenia, or can fade out. The setting for the fade out is the Style
setting at the top of the
options window. You can
see here the difference
between the drop shadow
and the long shadow.

Along with the shadow
style are a couple of other
settings that give
interesting options. You
can make the shadow very
short, essentially creating
3D text, or you can make it
fade out like I did above,

GIMP Tutorial: Top GIMP Filters, Part 2
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plus set how soon it starts to fade out (in the case of fading, the length setting
decides the length of the visible fade). Or, with the Composition setting, you can
make the shadow visible and the text itself invisible.

Vignette

Vignette is basically a shadowed frame around the photo. Choose a photo and
then choose Vignette (which is also in the Light and Shadows section of the
filters).

When you first start the filter, the default looks like this (top, right):

The shape can be a circle, square, diamond, or horizontal or vertical. You’ll have
to experiment to see what works best for your photo. The tutorial I’m referencing
says that you should use this filter on nearly any photograph to accent it, but that
it should barely show at all. The other settings will help you accomplish that. This
picture of a Colorado mountain lake has the Vignette filter applied (below). It has
ended up with a very faint shadow around the edges which emphasizes the
center of the photo (right).

Help PCLinuxOS Thrive & Survive

DONATE

TODAY

GIMP Tutorial: Top GIMP Filters, Part 2
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Add Border

In Vignette, we added a hint of a
border, but here, we’ll actually add
one. I’ll use the same photo. Click
Filters > Decor > Add Border. You
will get four settings:

Border X and Border Y determine
how wide, in pixels, you want your
border. The border color is default
white, but you can change to any
color you want. Delta value on color
makes some of the borders a different
shade so it can look like the light is coming from a specific direction. I used the
settings above and got this:

The Delta value is some sort of formula that shades part of the border differently.
Setting it higher seems to darken it, but you should probably experiment.

Bump Map

We actually did Bump Map in the September, 2015 issue. It is essentially a way
to incorporate the background texture into a graphic you have put in the image.

We used text before, but could use some sort of logo if we wanted. Also, you
should choose a background you’d like to use. I’ll go back with the brick wall I
used before because the effect is cool. I added, on another layer, a small logo
that I made.

Choosing the layer that has the logo, click on Filters > Map > Bump Map. In the
window that appears, first click on Aux. Input. Another window will open. On the
left side is everything you have open in GIMP. When you click on your project, the
layers will appear on the right side. You should choose the background texture
you want to use. I chose the Brick Wall layer.

GIMP Tutorial: Top GIMP Filters, Part 2
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Once you choose the background, the effect will begin to be visible. The rest of
the settings are for fine-tuning. The Compensate checkbox can lighten up your
logo, if you think the bump map has darkened it up. The Ambient Light slider
towards the bottom does mostly the same. Azimuth changes the direction of the
light. Elevation makes the texture more prominent, but I think it’s because of the
elevation of the logo layer (how high off the background it is) because the higher
number lessens the effect. Depth also makes the texture more prominent. I
would say that you should play with these settings to get the effect you want. The
picture below has the Split View activated, so you can see the before on the right
and after on the left. When you are happy with your effect, click OK.

Little Planet

This is a fun, different filter that works best with skyline photos. When you click
Filters > Map > Little Planet, GIMP will rearrange your skyline into a circular
pattern. You have zoom and rotate settings, along with another setting that can
change the angle of the photo (top right and right).

There are many more filters in GIMP, but these are some that could be used a lot.
Many of them have settings you just have to mess with. I liked Davies’ list,
though, and I hope you did too.

Like Us On Facebook!

The PCLinuxOS Magazine

PCLinuxOS Fan Club
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1. All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

Disclaimer
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by Free Software Foundation
Press Release

Boston, Massachusetts, USA -- February 9th,
2021. The Free Software Foundation (FSF) has
been awarded a four-star and 100% rating, the
highest possible, from Charity Navigator, the largest
independent evaluator of US-based nonprofit
charities. The FSF was also selected for Charity
Navigator's "Top Ten List" as one of "10 Charities
Worth Watching." These designations exemplify the
FSF's strong financial health and commitment to
accountability and transparency.

Using objective analysis, Charity Navigator awards
only the most fiscally responsible organizations a
four-star rating, with metrics including governance,
ethical practices, operations in accordance with
industry best practices, and openness with donors
and stakeholders. This is the eighth year in a row the
FSF has received a four-star rating, a record
attained by only six percent of the 160,000 charities
evaluated by Charity Navigator. The FSF also
earned perfect scores on "Financial Health" and
"Accountability & Transparency," resulting in the
organization's first-ever 100% rating, an
accomplishment less than one percent of all
charities evaluated by Charity Navigator are able to
achieve. This is the second time the FSF has placed
in the list of "10 Charities Worth Watching."

"The Free Software Foundation's exceptional four-
star rating sets it apart from its peers and
demonstrates its trustworthiness to the public,”
according to Michael Thatcher, President and CEO
of Charity Navigator. “Only a quarter of charities
rated by Charity Navigator receive the distinction of
our four-star rating. This adds the FSF to a
preeminent group of charities working to overcome
our world’s most pressing challenges. Based on its
four-star rating, people can trust that their donations
are going to a financially responsible and ethical
charity when they decide to support the Free
Software Foundation."

FSF executive director, John Sullivan, shared: "This
is truly an accomplishment requiring the whole
organization's efforts. It reflects excellence by our
board of directors in its leadership, especially
overseeing the FSF's financial management and key
organizational policies, and by our whole staff, doing
their work with exceptional efficiency and diligence,
focused precisely on the FSF's mission. This is full
validation of our supporters' confidence that when
you contribute to the FSF, that hard-earned money
will substantially advance the cause of software
freedom."

The FSF's Charity Navigator profile can be visited at
https://www.charitynavigator.org/index.cfm?bay=sear
ch.summary&orgid=8557.

About the Free Software Foundation

The Free Software Foundation, founded in 1985, is
dedicated to promoting computer users' right to use,
study, copy, modify, and redistribute computer
programs. The FSF promotes the development and
use of free (as in freedom) software -- particularly
the GNU operating system and its GNU/Linux

variants— and free documentation for free software.
The FSF also helps to spread awareness of the
ethical and political issues of freedom in the use of
software, and its Web sites, located at https://fsf.org
and https://gnu.org, are an important source of
information about GNU/Linux. Donations to support
the FSF's work can be made at
https://donate.fsf.org. Its headquarters are in Boston,
MA, USA.

Donate To PCLinuxOS
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Editor’s Note: Tip Top Tips is a semi-monthly column in
The PCLinuxOS Magazine. Periodically, we will feature –
and possibly even expand upon – one tip from the
PCLinuxOS forum. The magazine will not accept
independent tip submissions specifically intended for
inclusion in the Tip Top Tips column. Rather, if you have a
tip, share it in the PCLinuxOS forum’s “Tips & Tricks”
section. Your tip just may be selected for publication in
The PCLinuxOS Magazine.

This month’s tip is from Archie.

The HEVC (High Efficiency Video Coding) encoder
has been available since around 2013, and until
recently very few videos were encoded in this
format. First of all there are a handful of benefits to
HEVC, which you can read at
https://linuxreviews.org/High_Efficiency_Video_Codi
ng.

The purpose of this is to show you how I converted a
27 MiB video into the same MP4 format (the same
resolution, the same duration) at only 11.4 MiB,
using VLC. These are the two files:

- rw- rw- r- - 1 archie archie 11940902 Aug 28
22: 41 Mom- Is- Magic_1. mp4

- rw- rw- r- - 1 archie archie 28279772 Aug 22
21: 28 Mom- Is- Magic. mp4

Using ffprobe <video_filename>, here are the
technical details: The first file is Mom-Is-Magic.mp4.

Input #0, mov, mp4, m4a, 3gp, 3g2, mj 2, from
' Mom- Is- Magic. mp4' :

Metadata:
maj or_brand : isom
minor_version : 512
compatible_brands: isomiso2avc1mp41
encoder : Lavf58. 29. 100

Duration: 00: 02: 09. 11, start: 0. 000000,
bitrate: 1752 kb/s

Stream #0: 0(und) : Video: h264 (High)
(avc1 / 0x31637661) , yuv420p(tv, bt709) ,
1280x714 [SAR 1: 1 DAR 640: 357] , 1381 kb/s,
23. 98 fps, 23. 98 tbr, 24k tbn, 47. 95 tbc
(default)

Metadata:
handler_name : VideoHandler

Stream #0: 1(und) : Audio: aac (LC) (mp4a
/ 0x6134706D) , 48000 Hz, stereo, fltp, 365
kb/s (default)

Metadata:
handler_name : SoundHandler

Note that on Stream #0:0(und) the video was
encoded using h264. The other video file is Mom-Is-
Magic_1.mp4.

Input #0, mov, mp4, m4a, 3gp, 3g2, mj 2, from
' Mom- Is- Magic_1. mp4' :

Metadata:
maj or_brand : isom
minor_version : 0
compatible_brands: mp41avc1
creation_time : 2020- 08-

28T14: 41: 16. 000000Z
encoder : vlc 3. 0. 11. 1 stream

output
encoder- eng : vlc 3. 0. 11. 1 stream

Tip Top Tips: How I Converted My H.264 Video To HEVC
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output
Duration: 00: 02: 08. 92, start: 0. 000000,

bitrate: 740 kb/s
Stream #0: 0(eng) : Audio: mp2 (mp4a /

0x6134706D) , 44100 Hz, stereo, fltp, 127
kb/s (default)

Metadata:
creation_time : 2020- 08-

28T14: 41: 16. 000000Z
handler_name : SoundHandler

Stream #0: 1(eng) : Video: hevc (Main)
(hev1 / 0x31766568) , yuv420p(tv, bt709) ,
1280x714 [SAR 1: 1 DAR 640: 357] , 606 kb/s,
23. 97 fps, 23. 98 tbr, 1000k tbn, 23. 98 tbc
(default)

Metadata:
creation_time : 2020- 08-

28T14: 41: 16. 000000Z
handler_name : VideoHandler

Note that on Stream #0:1(eng) the video was indeed
encoded in hevc. I have to highlight the
significant reduction in file size without losing
video and sound quality from the original copy.

What I did on the VLC menu was click on Media >
Convert / Save (Ctrl+R). On the File tab, click Add
then Open the video you want to convert. Once
listed, click Convert/Save.

Check that the Source is the actual file you wanted
to convert. On the Settings section of the dialog
window, you'll see Profile and a down arrow. Click to
change the Profile to Video - H.265 + MP3 (MP4) or
you can create your own profile using the
(Encapsulation) MP4, (Video codec [enable Video] >
Codec) H-265 (Note: also check that the resolution
scale is set to either Auto or 1 or you can shrink your
video dimensions), (Audio codec [enable Audio] and
enable Keep original audio track or as I prefer,
change the codec to MPEG 4 Audio (AAC)) ...
Subtitles? If you're creating a new profile, do not
forget to give it a Profile Name so it'll be easier to
find next time.

The last part is the Destination. You will need to click
on Browse, navigate to the folder where you want to

save your file, and click Save. When all is ready,
click Start and wait for VLC to complete the task.
Depending on the duration of your video, it may take
a couple of minutes or longer.

OR if you prefer the command line (which is much,
much simpler):

ffmpeg - i
<original_video_fiilename. extension> - c: a
copy - c: v libx265 <new_video_filename>. mp4
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You can make a great pizza crust that does not fall
apart after baking, from this recipe. Hold it, slice it,
roll it up, eat it - it holds its shape and it actually
tastes like pizza. This cauliflower pizza crust is
gluten free and definitely worth trying.

Ingredients:

3 - cups cauliflower (grated)
1 1/2 - cups parmesan cheese (shredded)
2 - eggs (beaten)
1/2 - tsp salt
1/2 - tsp black pepper
1 - tsp oregano
1 - tsp basil
1 - tsp onion powder (optional)

In a large nonstick pan, heat the cauliflower on low
heat for 15 to 20 minutes, stirring constantly. The
object here is not to cook the cauliflower, but to get
rid of excess moisture. After the moisture is
removed, move the cauliflower to a large bowl to
cool.

Add the beaten egg, parmesan cheese and spices
to the cauliflower and mix until everything is well
coated.

On a pizza pan or large baking sheet, place a sheet
of parchment paper and lightly grease (I use a
nonstick cooking spray). Pour ingredients in the
middle of the paper, and flatten to about 1/4 inch
(6.35mm).

Bake at 400°F (205°C) for 20 to 25 minutes.

Remove from the oven and allow to cool. Add
favorite toppings, and bake at 425°F (218°C) for
another 20 minutes.

It's easier than E=mc2
It's elemental

It's light years ahead
It's a wise choice

It's Radically Simple
It's ...

The PCLinuxOS
Magazine

Created with
Scribus
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by Alessandro Ebersol (Agent Smith)

There is an old Spanish saying that goes like this:
“don't breed Crows, they’ll sting your eyes,” and this
saying fits perfectly with the class of American tech
companies, the so-called Big Techs.

Yes, with a few exceptions, most Big Techs were
born as projects of the US government, US Army,
CIA or NSA. Or, they are entwined with the American
government, in one way or another.

I stress that everything that has been written in this
text is not secret. It is available on several websites
on the internet, and, there is nothing new here. Just
search, and anyone will find this information.

The CIA has grown too much,
and so have its tentacles

The CIA, the American Central
Intelligence Agency, was born
in 1947, as a successor to the
OSS (Office of Strategic

Services), which was the agency that operated
during World War II.

The CIA expanded rapidly outside its intelligence-
gathering mandate, to include covert operations and
unauthorized operations (the so-called black ops).
By providing funding and organization, it proved to
be a vital step in the development of a fief within the
American state, an organization that has grown so
much that it has become an end in itself.

It can be said today that the CIA is an almost
autonomous body, which responds to the President
and the American Congress, but only if investigative
committees are set up.

With so much looseness about its actions, the
"company” “had enough freedom to create its own
venture capital firm, In-Q-Tel.” In the words of a
former CIA director, George Tenet, "We [the CIA]
decided to use our limited dollars to leverage
technology developed elsewhere. In 1999 we
created In-Q-Tel. While we (CIA) are paying the bills,
In-Q-Tel is independent of the CIA. The CIA
identifies pressing problems, and In-Q-Tel provides
the technology to solve them. The In-Q-Tel alliance
has put the agency back at the forefront of
technology. This collaboration allowed the CIA to
take advantage of the technology Las Vegas uses to
identify crooked card players and apply it to analysis
for terrorists, and to adapt the technology online
booksellers use and convert it to scour millions of
pages of documents for unexpected results.”

Outsourcing the CIA's activities is also a way to keep
them hidden from public opinion, since private
companies do not have to account for their activities.
Hillhouse wrote on July 8, 2007, in the Washington
Post, “Tell me that more than 50% of the National
Clandestine Service (NCS) - the heart, brain and

soul of the CIA - has been outsourced to private
companies such as Abraxas, Booz Allen Hamilton,
Lockheed Martin and Raytheon.”

Startups that received funds from In-Q-Tel

Now, let's list some technology companies that have
received funds from In-Q-Tel:

Google For two decades, the US intelligence
community (CIA, NSA and DARPA) worked closely
with Silicon Valley in an effort to locate citizens in
cyberspace. Google is at the heart of this origin
story. Some of the research that led to Google's
ambitious creation was funded and coordinated by a
research group established by the intelligence
community to find ways to track individuals and
groups online.

I myself wrote a series of eight articles that
appeared here in The PCLinuxOS Magazine on the
genesis of Google, so there is not much else to talk
about here. It is a company that has in its roots a
close association with the American intelligence
bodies.

Don't Breed Crows:
How Big Techs Started Out As US Government Projects,

And Today They Threaten Democracy
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Facebook LifeLog was a project of the Office of
Information Processing Techniques of the Defense
Advanced Research Projects Agency (DARPA) of
the United States Department of Defense (DOD).
According to its 2003 bid request pamphlet, it would
be “an ontology-based subsystem that captures,
stores, and makes accessible the flow of a person's
experience and interactions with the world in order
to support a broad spectrum of associates/assistants
and other system capabilities.” The purpose of the
LifeLog concept was to "be able to track the life lines
of an individual in terms of events, states, and
relationships”, and the system has the ability to
“monitor all of a subject's experiences, from dialed
phone numbers, from read email messages, to every
breath taken, every move made, or place visited.”
Scary, right?

The government funded the initial money for
Facebook through the CIA's personal venture capital
investment firm, In-Q-Tel, and then, through a sort of
revolving door scheme, they (Facebook) just hired
DARPA executives to work for the same companies
they had helped create since its inception. Regina
Dugan, for example, ran Facebook's "Building 8,"
where DARPA and government-funded projects are
being implemented. Before that, Regina Dugan left
DARPA for Google and then for Facebook Building
8. Where she’s going to appear next, no one knows,
but we can be sure it's probably some kind of
government spying initiative or a CIA DNA data
capture cloud.

Oracle Founded in May 1977, the company's name
came from a CIA project called Oracle. Company co-
founders Larry Ellison, Robert Miner and Ed Oates
worked on the Oracle project at a consulting firm
before working on their own.

Larry Ellison wrote in the New York Times in January
2002: "The only step that Americans could take to
make life harder for terrorists would be to ensure
that all information in numerous government
databases is copied to a single, comprehensive
national security database."

But who watches the watchmen? Who's to say that
only the "bad guys" are in these databases?

Maybe they shouldn't create these databases. Even
assuming the best-case scenario, in which Oracle is
not actively enabling all kinds of domestic
espionage, which Americans have rightly been
concerned about since the Snowden revelations, it
seems that the quality of the company's product
security are still cause for concern.

"Of all commercial databases, Oracle is the least
secure," British security expert David Litchfield
recently told Reuters. This is a problem, both from
the point of view of national security and even from
the point of view of consumer confidence. Because
today, everyone uses Oracle databases, and they're
subject to data theft by external crackers.

Microsoft The company that was born in 1975 in
Albuquerque, New Mexico, as a creator of BASIC
interpreters for microcomputers, and then, through a
series of misadventures, became the largest
software company in existence, also has very deep
ties to intelligence agencies.

Microsoft has been working closely with U.S.
intelligence services to allow users' communications
to be intercepted, including helping the National
Security Agency circumvent the company's own
encryption, according to top-secret documents

obtained and leaked by Edward Snowden in 2013.
These documents show the complicity of several
technology companies, in the so-called Prism
project.

The documents demonstrate that:

• Microsoft helped the NSA circumvent its
encryption to address concerns that the agency
would be unable to intercept web conversations
on the new portal Outlook.com.

• The agency already had pre-encryption access to
the email in Outlook.com, including Hotmail.

• The company worked with the FBI in 2013 to allow
the NSA easier access via Prism to its cloud
storage service SkyDrive, which now has more
than 250 million users worldwide.

• Microsoft also worked with the FBI's data
interception unit to "understand" potential
problems with a feature in Outlook.com which
allows users to create fake names by email.

• In July 2012, nine months after Microsoft bought
Skype, the NSA boasted that a new capacity of its
system had tripled the amount of Skype video
calls being collected through Prism.

Don't Breed Crows: How Big Techs Started Out As US Government Projects, And Today They Threaten Democracy
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• Material collected through Prism is routinely
shared with the FBI and CIA, with an NSA
document describing the program as a “team
sport.”

Now, I invite you to think a little. I've known Microsoft
for many years, and this company amasses more
flops than hits. Indeed, Microsoft, were it any other
company, would have been bankrupt and closed for
many years now. But no. It looks like they have a
cash printer in Redmond, or does the American
government not let the company break, to not lose
its source of backdoors ? Something to think about.

Other than these companies, In-Q-Tel invests in
other, little-known companies ranging from video
games and virtual reality, to big data and data
capture from social networks.

But, but, Big Techs generate a lot of jobs and
taxes for governments. They develop the place
where they operate.

Just they don't. Big Tech are vertical organisms that
only generate benefits for themselves.

Let me explain.

If I have a car factory, the production is horizontal.
As a car manufacturer, I'm going to need tires, car
seats, windshields, and not everything I can
produce. Thus, when a car factory settles in a city, it
generates benefits for everyone in the city: rental
houses for workers, restaurants, for employees,
other companies that will produce items that will be
used in cars (windshields, mirrors, tires, etc.). Thus,
it is a virtuous circle, where everyone close to the
factory profits from its production.

Only big techs aren't like that. They are extremely
vertical companies. That is, they produce the raw
material of their final products themselves. And, the
thing is going to a point, that the big Microsoft and
Apple want to stop using third-party chips and

manufacture their own processors, not to depend on
other factories anymore. Thus, they would have full
control of the production and prices charged. But
don't think a MacBook is going to get cheaper
because of it. No, Apple's profit margin is going to
get bigger.

But, with their data centers, big techs move the
local economy. After all, they must have
buildings with servers and people to operate
these servers.

Negative. The big techs are very scattered around
the globe, and often rent servers around the world,
wherever it is cheaper. Or, when they choose a
location to set up a data center, it's usually a cheap
place, with plenty of water (to cool their servers) and,
small towns, where the cost of living is low.

Since data centers are operated remotely, they do
not need to have a very large staff, so staffing costs
are kept low. That is, they do not move the local
economy much, but they benefit the shareholders.

But, but, the Big Techs must hire a lot of
programmers. And this staff should earn well.

No again. Usually, these companies hire technical
personnel from countries such as Pakistan, India,
Thailand, the Philippines (formerly China, but now
specialized labor is being harnessed in the country
itself), which are generally cheaper than workers in
countries with a more parity exchange with the
dollar, thus keeping the cost with staff low.

Some examples that have been documented in the
media are:

Microsoft (where’s my surprised face?) - India

In 2010, Microsoft signed a three-year contract with
Infosys Technologies to manage significant portions
of its internal IT operations worldwide. The

agreement included specific services such as
technical assistance, database management,
software applications and devices. The agreement
covered more than 450 locations across 104
countries.

Located in Bangalore, India, Infosys had already
partnered with Microsoft in certain areas, but this
particular business further expanded that
relationship. Infosys has also partnered with Unisys
Corporation in Pennsylvania to provide technical
support to desk and deskside service to Microsoft
employees. This Agreement has seen Infosys
improve its capabilities to help other customers
leverage Microsoft innovations and adopt new
technologies.

General Electric (GE) - India

General Electric decided to focus on India and
invested about $130 million in the creation of a large
state-of-the-art research and development center in
Bangalore, India. This center is General Electric's
largest research and development center and the
company's second largest in the world and has
qualified Indian professionals. The center is
equipped with the latest engineering and technology
tools and is responsible for interacting with GE
customers, suppliers, subsidiaries, partners and
other technology centers around the world.

General Electronics also has a technology center in
India that employs more than 2,200 engineers and
scientists with Chemical Engineering, Mechanical
Engineering, Polymer Science and new synthetic
materials. GE has also opened an E-knowledge
center in India to disseminate knowledge and
technological developments to its business centers.

CISCO - India

The famous networking giant has invested more
than.150 million in structuring and expanding its
technology development company in India. Cisco
has also set up its second largest R & D facility in
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Bangalore, India, which is home to over 1500 Indian
technical professionals. Cisco's research and
Development Center in Bangalore was developed to
help the company deploy products and solutions
faster, develop new technologies, as well as
successfully meet customer demand by providing
technical support. Cisco also has plans to make
more investments in India and leverage the skills of
Indian network professionals. The type of support
offered is the Live Chat Support Services and email
support service.

Other than that, we have call centers, which, most
often, are located in India.

But, but, Big Techs should generate bill ions in
taxes and help the economy, right ?

No, definitely not. In fact, ALL, ALL Big Techs have
tax evasion schemes.

And, amazingly, it seems that Ireland's climate must
be very good, since Apple chose Ireland to be its
headquarters in Europe. Google also chose Ireland
for its European headquarters.

No, it has nothing to do with weather. Apple has
settled in Jersey, the small island in the English
Channel that, like many Caribbean havens, does not
charge corporate profits taxes to most companies.
Jersey would play a significant role in the new Irish
tax structure set up by Apple, created in late 2014.
Backed by this deal, the MacBook maker continued
to enjoy ultra-low tax rates on most of its profits and
now holds much of its earnings outside the U.S. on a
$252 billion offshore cash mountain.

Google has also settled in Ireland, and maintains
remittances of profits to tax havens in Bermuda. By
legally channeling the profits of foreign subsidiaries
in Bermuda, which have no corporate income tax,
Google has reduced its overall tax rate by almost
half.

Microsoft, for its part, hid US$108 billion in offshore
profits, using a network of foreign subsidiaries to
dodge U.S. taxes, bringing its tax rate to a tiny 4.5
percent in its offshore profits. This is lower than most
middle-class families pay in taxes.

Microsoft began building this tax maze more than 20
years ago when it changed software royalty rights to
a fictitious company in Nevada to avoid a fee in its
home state of Washington. This first domestic
evasion eventually grew into the company's current
tax evasion system based on tax havens around the
world.

Well, now that communications have migrated in
droves to the internet, at least we're sure there's
democracy to spread ideas, thanks to Big Techs!

That couldn't be further from the truth. Let's take a
look at the past. Let's remember Germany in 1933...

When the German Ministry of Propaganda was
born, and why was it born

Joseph Goebbels,
minister of propaganda

Founded on March 14, 1933, a few months after the
Nazi takeover of power by Adolf Hitler's government,
it was led by Reich Minister Joseph Goebbels. The

role of the new ministry, which established its offices
in the Orderpalals in front of the Reich Chancellery,
was to centralize Nazi control of all aspects of
German cultural and intellectual life. An undeclared
goal was to present to other nations the impression
that the Nazi Party had the full and enthusiastic
support of the entire population. Censorship in
Germany was vital to the maintenance of political
control by the Nazis. He was responsible for the
control of German media, literature, visual arts,
cinema, theater, music and Broadcasting.

And by controlling the media, Goebbels would
control the narrative. And whoever controls the
narrative controls the truth. After all, the facts,
according to Goebbels, should be slaughtered, until
reality is reduced to a mere matter of opinion. The
truth? A simple choice of sides. My truth against your
truth. Until one no longer knows how to distinguish
what is true and what is not.

And after more than 70 years of these events,
they repeat themselves…

On November 5 last year, the president of the United
States, Donald Trump, noted the “historical
interference in the elections of big money, big media
and big tech” and labeled the Democratic Party as
“the party of the big donors, the big media, the big
technology”. On January 6, 2021, during his speech
to the crowd of protesters who stormed the U.S.
Capitol, Trump accused the Big Techs of rigging the
election and veiled banishment of conservatives,
while promising to hold them accountable and work
to get rid of Section 230. On January 11, after
Trump's Twitter account was suspended, German
Chancellor Steffen Seibert's chief spokesman noted
that Angela Merkel considers the suspension of
Trump's account "problematic," adding that
lawmakers, not private companies, must decide on
any necessary restrictions on free speech, and
whether speech incites violence or not.
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So Big Techs control the media, now mostly
occurring over the internet, these companies decide
what's good, and what's bad. What can be broadcast
and what should be silenced, controlling the
narrative and, lately, the perceived "truth".

But what truth is that? One that corroborates the
narratives of Big Techs, which have grown so much
that they can't be regulated anymore (thanks to a lot
of lobbying in the U.S. government, they almost
always escape without a scratch).

Scott Galloway, a staunch critic of Big Techs, argued
that the current situation is the result of economic
deregulation, globalization and the failure of
politicians to understand and respond to
technological developments. And in this ignorance,
these vultures thrive.

A brief word before the end…

President Kennedy regarded the ClA as a nuisance,
something that hindered the U.S. government more
than it helped. So much so that he promised to
break the ClA into a thousand pieces and spread
them in the wind.

He was assassinated before that happened, and
much is speculated about the role of a renegade ClA
in this episode.

Trump also wanted to end section 230, hold Big
Techs accountable for their actions, their opinions,
and, more importantly, for the censorship these
companies exert in their vehicles. He ended up
virtually "murdered." Things to think about.

In a next opportunity, I want to discuss what is the
purpose of this technology oligopoly, which today,
along with the financial complex, controls the
Western world.

Until then, be careful with your Twitter accounts,
email, Facebook, etc.

Screenshot ShowcaseScreenshot Showcase

Posted by brisvegas, on February 1 , 2021 , running Mate.
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by Meemaw

In January, ms_meme posted in the forum that she had been using a program
called Fotowall, and was wanting a bit of help. I downloaded it and started talking
to her. Turns out that it’s a nifty little program if you want to make a photo collage.
It has other features, so I’ll cover some of them, too. It’s a pretty nice little
program, but it has some problems and limitations.

There’s a beginning screen, which says Create in the center at first. After you’ve
saved a project it looks a bit different, listing your previous projects at top left so
you can open one if you want. Click on Create.

Here’s the main screen.

The toolbar is pretty simple (top, right)… but it doesn’t have NEAR the tools that
GIMP and Inkscape have. However, if you just want to arrange some photos and
export the resulting collage, it works well.

The things you insert are separate layers (from left to right above - Pictures, Text,
Wordcloud, Canvas and Search Web Pictures). I looked at Add Canvas, but that

asks for something with a filename extension of .fotowall, so I’m not sure about
that. The projects are saved with that extension, so maybe it’s inserting an
already made canvas into a new project. Search Web Pictures is pretty limited
as it only lets you search Flickr. Your best bet is to search for yourself and then
use the Add Picture tool.

Whatever layer you are on shows in the next section. I was using the Wordcloud
layer when I took the screenshot above. The tools to the right include a Stack
dialog and an effects dropdown (for the layer). The slider is to change the opacity
of that blue layer background and the pink dot is in the middle of a grid where you
can change the perspective. The wrench has some more tools.

In the bottom right corner of the layer you are working on is the same wrench, a
four-pointed star for perspective, and an X to delete that layer.

If you click the wrench there, you get mostly
the same tools.

If you’re going to do a collage,
choose Add Picture. You will
be able to navigate to the folder
that contains your photos.

Create A Collage or Wordcloud With Fotowall
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Choose several photos. I’m not yet sure what the limit is, but you can safely
choose 12 (I already did a collage with that many).

Your photos will be inserted in a stack, and from there you can grab each one
and move it, enlarge or reduce it and rotate it, until you have them arranged the
way you want. While you’re at it, highlight the photo file name and put in a title for
that photo (top, right).

Clicking outside the photos and in the window, you can set a black, white or
gradient background for your collage.

In the top right corner, you can save it as a Fotowall file, or Export it as an image
file. If you Export, you’ll get the following windows, with a filename dialog in
between (right).

ms_meme was trying to create a Wordcloud, so that’s mainly what we discussed.
When you select Add Wordcloud, you need a list of words you want included. I
make word lists for the puzzles, so I condensed and used one called family.txt.

The first couple of times I tried the Wordcloud, I didn’t get anything, but I did it
after I added a graphic, so I inserted the Wordcloud first, and it worked fine.
There are a couple of windows that pop up and ask (1) how many letters the
smallest word is, and (2) how many words are in the list. The defaults are 3 (for
number of letters in the smallest word) and 100 (for number of words).

I had a little trouble at first and would get a layer with no words in it (maybe a
glitch?) but after a couple of tries I got a pretty good Wordcloud (next page, top
left).

Create A Collage or Wordcloud With Fotowall
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Also, using the opacity tool, you can choose black shadow, and it will shadow the
layer… but if you set the opacity to zero (the blue will be gone), the shadow goes
to the words. I like that better.

Also, you can double click on the Wordcloud layer and it will bring you to another
set of directions. Here, you can move individual words around, but there doesn’t

seem to be a way to save your changes to your original Wordcloud. It won’t
change the font either - even though there’s a list of fonts, or the color scheme -
even though there are 3 to choose from. If you click back to Canvas, the
Wordcloud is just gone… no saving, no alterations, nothing, just an empty layer.
This is the frustrating part!

If you click outside the Wordcloud, on the background layer, the toolbar will
change from saying ‘Wordcloud’ to saying ‘canvas’.

The dropdown that says Screen apparently is a size setting because the others
say Exact Size, Desktop CD Cover and DVD Cover (which are all different sizes).
The dropdown that says Background has None, White, Black and Gradient. If you
choose Gradient, then move your mouse
pointer to the bottom right of the window, and
you can choose your gradient by moving the
plus sign to the color you want. Then you can
make it lighter or darker by moving the arrow
up or down in the bar at the right.

If you add a picture, then click the wrench in
the right corner of the layer, and you can
eliminate the blue background by clicking on
the x under Looks. I haven’t been able to copy
& paste, so if you want to add two copies of a
picture, you have to add it twice.

The boxes at the corner of your active layer are the resize and rotate boxes.
Clicking & dragging in the layer allows you to move it wherever you want it.
However, I haven’t found a way to make the Wordcloud fit a specific shape. You
may have to make your own to get that. The four-pointed plus sign in the tools is
the perspective tool, which you can use to “twist” your layer (next page, top left).

Export lets you save your creation as several things. I haven’t tried them all yet,
but I have saved this one as a .png. After you click OK, it always tells you what
size your finished picture is (next page, bottom left).

Create A Collage or Wordcloud With Fotowall
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If you choose Wallpaper, you are asked the same questions as the scale mode
on your Image save window (Zoomed, Scaled, keep proportions, Scaled and
Original). I chose Scaled, keep proportions, and clicked Finish. However, my
wallpaper didn’t change.

If you choose Poster with PosteRazor, you will get a window that asks if you
want to go to the PosteRazor website, or watch a tutorial, or click finish and open
PosteRazor. This is a program which lets you load a document and enlarges it to
print as a large poster, but on letter or legal sized paper.

The other choices are Print, PDF or SVG (Scalable Vector Graphics can be
edited and manipulated in Inkscape).

Setup ONLY lets you enable OpenGL, which is a graphics accelerator. Mine’s
working fine right now so I didn’t bother with it.

Fotowall is a pretty good program for what it does, but it has some problems. It
does the collages pretty well, but the Wordclouds confound me as there seem to
be several glitches in the program. If I wanted my words arranged a specific way,
however, or a different font, I would fall back to Scribus. There are also a few
good internet sites you can use to make Wordclouds. The downside to Fotowall is
that it apparently hasn’t had much, if anything, done to it since 2017. Hopefully,
they will update and improve it soon.
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SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can
view them here. You have seven (7) letter
tiles with which to make as long of a word
as you possibly can. Words are based on
the English language. Non-English
language words are NOT allowed.
2. Red letters are scored double points.
Green letters are scored triple points.
3. Add up the score of all the letters that
you used. Unused letters are not scored.
For red or green letters, apply the
multiplier when tallying up your score.
Next, apply any additional scoring
multipliers, such as double or triple word
score.
4. An additional 50 points is added for
using all seven (7) of your tiles in a set to
make your word. You will not necessarily
be able to use all seven (7) of the letters in
your set to form a “legal” word.
5. In case you are having difficulty seeing
the point value on the letter tiles, here is a
list of how they are scored:

0 points: 2 blank tiles
1 point: E, A, I, O, N, R, T, L, S, U
2 points: D, G
3 points: B, C, M, P
4 points: F, H, V, W, Y
5 points: K
8 points: J, X
10 points: Q, Z

6. Optionally, a time limit of 60 minutes
should apply to the game, averaging to 12
minutes per letter tile set.
7. Have fun! It's only a game!

SUDOKU RULES: There is only one valid solution to each
Sudoku puzzle. The only way the puzzle can be considered
solved correctly is when all 81 boxes contain numbers and the
other Sudoku rules have been followed.

When you start a game of Sudoku, some blocks will be prefilled
for you. You cannot change these numbers in the course of the
game.

Each column must contain all of the numbers 1 through 9 and
no two numbers in the same column of a Sudoku puzzle can
be the same. Each row must contain all of the numbers 1
through 9 and no two numbers in the same row of a Sudoku
puzzle can be the same.

Each block must contain all of the numbers 1 through 9 and no
two numbers in the same block of a Sudoku puzzle can be the
same. D

o
w
n
lo
a
d
P
u
z
z
le
S
o
lu
ti
o
n
s
H
e
re

Possible score 218, average score 153.

PCLinuxOS Puzzled Partitions
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BAGPIPE BANSHEE

BLARNEY STONE BROGUE

CELEBRATE CELTIC

CLOVER COINS

DONNYBROOK EMERALD ISLE

FORTUNE FOUR LEAF CLOVER

GAELIC GOLD

GOOD LUCK HOLIDAY

IRISH LEGEND

LEPRECHAUN LIMERICK

LUCK OF THE IRISH MAGICAL

MISCHIEF MISCHIEVOUS

PATRON POT OF GOLD

RAINBOW SAINT PATRICK

SHAMROCK SHILLELAGH

TRADITION TRIFOLIUM

WALKING STICK

WEARING OF THE GREEN

Download Puzzle Solutions Here
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T A E S F M E L G H N Y I N X W F E G O L X A U H Z D T V X

R A L R Y E Z B P B S A H K Y E N V B L W K P S P L R C J E

A U R N C O I T F B E N E T R B X O D B H U T G N A N Q R M

D Z O Y J G X G W Z B W A E R D B L B C K S R D P J I C K K

I G C O J X J E D L A Y F B S E R C N G V W I Z D D V B G R

T C E B V G J E T C U A S A T Q J F F E G X F L C A Q M V Y

I V L C K X O Z H O L I D A Y J V A T O H M O J W R K I W W
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V I C D J E I P U G E M A G A M N R O O C C U N A X L H R F
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X C O T R E Q G B L R S C I M B J U G L C A K U T F T Y E N

N K R W T S K E O B T I S H J I B D I E B U A N R B F O G E

Q O K R H G B L Y F R G O A G N E D C L I N L G O J O T R Y

N W M J H L G N E B N O G E U F K L A L P D H Q F U K D E S

F X F P J Y N I Q U F T G L Q D K U L I N X G I V Y C K E T

A A G A F O Y C U C B R Y U N M I S C H I E F B R O U F N O
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1. It’s considered good luck to find one of these,
rather than its 3-leafed relative

2. The name of an Irish street ballad.
3. A cudgel of oak, blackthorn, or other hardwood

ending with a large knob.
4. Maliciously or playfully annoying.
5. One of the Celtic languages.
6. A story coming down from the past.
7. A plant having compound leaves with three

small leaflets
8. A wild brawl or a rowdy dispute.
9. A strong dialectal accent, especially a strong

Irish or Scottish accent when speaking English.
10. A branch of the Indo-European languages that

was spread widely over western and central
Europe in the pre-Christian era.

11. A genus of plants with characteristic 3 leaves,
like clover.

12. A light humorous, nonsensical, or bawdy
verse of five lines where the rhyme scheme
is aabba.

13. A woodwind instrument using enclosed reeds
fed from a constant reservoir of air in the form
of a bag.

14. In Irish folklore, a mischievous elf-like
creature or fairy who grants wishes or reveals
the location of hidden treasure when captured.

15. A stone in an Ireland castle, said to endow
whoever kisses it with the gift of the gab and
skill in flattery.

16. A description of Ireland.
17. The patron saint of Ireland and its national

apostle.
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Posted by jp, on February 28, 2021 , running LXDE.

Posted by OnlyHuman, on February 1 , 2021 , running e24.

Posted by luikki, on February 3, 2021 , running KDE.

Posted by The Cranky Zombie, on February 1 , 2021 , running KDE.
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